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1.  Introduction 
In this application note, we will discuss the design of a mode matched tuning fork gyroscope from an initial 
element-based model through device-level analysis to macromodel extraction and integration with a control 
circuit. We will analyze the gyro we have developed and discuss the benefits of IntelliSuite when it comes 
to MEMS-based inertial sensor design. Using IntelliSuite, one can optimize a design without having to go 
through the costly procedure of prototype development and testing. First, we will do some initial design 
exploration using a model built from scratch with system-level components (beams, plates, gaps, comb 
drive actuators, etc.). Taking advantage of the great speed of SYNPLE, IntelliSense’s system-level 
simulator, it is easy to optimize the design of a device using parametric analysis. We will then extract a 
mask layout from the SYNPLE schematic and use it to automatically create a 3D meshed model to be used 
for analysis. We will determine the natural frequencies of the gyro and will examine the device response in 
a static case and a dynamic case. We will then use a unique feature called N-degree-of-freedom System 
Model Extraction (N-DOF SME) to generate a system model of the device which retains the accuracy of 
the device-level model. We can incorporate this model into a system-level simulator like SYNPLE to co-
simulate the device with the CMOS control circuitry that will be used to govern and export the signals. 
 
1.1. Background 
 
Inertial sensors are common MEMS devices because the benefits greatly outweigh the costs when the 
MEMS based devices are compared to their earlier, larger, more complex counterparts.  Inertial devices 
were first designed for military applications.  They were used for guidance and navigation.  Early inertial 
devices were extremely large, bulky, expensive, and very complex from a manufacturing standpoint.  
More recently, they have been adopted by commercial industries (air bag sensors, etc.), which has led to a 
drive to make inertial devices cheaper and smaller.  This in turn has resulted in the adoption of MEMS 
technology in the fabrication of inertial devices because of the bulk manufacturability of the devices as well 
as the small size and weight associated with all MEMS devices. 
 
Inertial sensors use the inertia of a mass to sense acceleration or rotation.  The two major types of inertial 
devices are gyroscopes and accelerometers.  The accelerometer uses an inertial mass to sense acceleration 
along one of the three axes while the gyroscope uses a mass to sense a rotation around one of the three axes.  
Some are designed for sensing in multiple axes.  Accelerometers are usually single masses supported by a 
spring structure designed to allow the mass to move within a certain range under certain loading conditions 
depending on the desired sensitivity of the device.  Gyroscopes must be designed with multiple paths of 
motion in mind.  This is because they are constantly vibrated in one direction and when the device is 
rotated, the combination of the vibration and the rotation cause a Coriolis force which causes displacement 
along an axis perpendicular to the axis of rotation and the axis of vibration. 
 
1.2. The Gyroscope 
 
In this particular instance, we will examine a single axis gyroscope with two masses (Figure 1).  In this 
example, the two masses will be oscillated such that they both move towards the center of the device at the 
same time.  This will cause opposite velocities and keep the forces on the device balanced.  The device 
will use the capacitance between each moving mass and each of the four electrodes (shown in multiple 
colors in Figure 1) to sense the rotation-induced displacement.  Multiple electrodes are being used for 
noise cancellation and sensitivity. 
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Figure 1 Single-Axis, Two-Moving-Mass Gyro 
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2.  Element-based Design in SYNPLE  
SYNPLE, IntelliSense’s system-level simulator, can be used in a variety of ways. On one hand, MEMS 
elements like beams, plates, and comb drives can be used to build a device from scratch. The other method 
would be to import a macromodel from the FEA module. In both cases, the device can be wired up to a 
circuit that will be used to control the device. In this section, we will analyze a model that has been 
constructed from scratch with beams and plates. In Section 5, we will discuss the analysis of a macromodel. 
  
 
2.1. Model Construction 
 
Open SYNPLE. 
 
 Click Start…Programs…IntelliSuite…SYNPLE 
 
The schematic window will open. Users will see the schematic window on the right, the element library on 
the left, and the message panel on the bottom as shown in Figure 2. 
 

 
Figure 2 SYNPLE window  

 
In the element library window on the left,  
 

Click MEMS Elements 
  
This will open the MEMS element library as shown in Figure 3. 
 



 

4 

 
Figure 3 MEMS Element Library 

 
Click and drag an Anchor element into the Schematic window. Also, click and drag a Beam into the 
schematic window. Your SYNPLE Window should appear as shown in Figure 4. 
 

 
Figure 4 Dragging Elements into Schematic Window 

 
Now that you know how to add elements to the schematic window, we can start to build up the gyro device.  
Delete the elements you just created, and drag four Beam elements and three L-Joint elements into the 
drawing window (the L-Joint element can be found in the Beam Joints sub-menu). Connect these elements 
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as shown in Figure 5. To connect a beam to a joint, drag one element so that its pin lines up with the pin of 
the other element. A red square will highlight the connection when the pins are lined up. You can also 
hover the mouse over a pin and a pencil icon will show up. Click and drag to draw a wire from one pin to 
another.   
 

 
Figure 5 Connecting Beams 

 
To rotate elements, you can use the Rotate buttons in the toolbar at the bottom of the window.  
 

 
Figure 6 Format Toolbar 

 
Continue connecting beam and joint elements in the schematic window until the structure looks like that 
shown in Figure 7. You can continue dragging elements into the window from the element library, or you 
can use the Copy/Paste commands.   
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Figure 7 Beam Elements 

 
Drag two Rigid Plate elements and four Plate Joint elements into the schematic window. 
 

 
Figure 8 Adding Rigid Plate Elements 

 
Connect the Rigid Plate elements to the Beam elements with the Plate Joints. Note that it is always 
necessary to use the joint elements when connecting beams and plates.  
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Figure 9 Connecting Beams and Plates 

 
Next, we will add the comb drives. Drag two Comb Drive-1port elements into the schematic and connect 
them to the Rigid Plate elements as shown in Figure 10. Then, connect the nine other force pins on each 
plate to Knot elements as shown below. The Knot elements show that no forces or moments will be applied 
at these points. 
 

 
Figure 10 Comb Drive Elements 
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Drag two Anchor_II elements into the schematic window and connect them to the middle beams as shown 
below. It is possible to connect voltage, temperature, and power loads to this particular anchor. We need to 
define an electrical reference for the schematic, so select Electrical Ground from the Draw menu at the top 
of the screen, click in the schematic window to insert the element, and connect it to the voltage pin of the 
top anchor. 
 
Drag a Global Frame element into the schematic window. This element allows you to transfer global 
orientation, angular velocities, and accelerations from the global (chip) frame of reference to the local 
frame of reference. (More information on this or any element can be found in the Elements Documentation 
in the Help menu.) You will also need to connect a Constant element to each of the pins of the Global 
Frame (note that one Constant element can be connected to multiple pins). The Constant element can be 
found in the Sources sub-menu under the General Elements library. In this case, the value of all the 
constants connected to the Global Frame will be left at zero. 
 
Your schematic should now look like the one below. 
 

 
 

Figure 11 Structural Elements of the Gyro 
 

Insert a Voltage AC Source element, located in the Sources sub-menu in the Electrical Elements library. 
Connect the positive pin to the voltage pin on each of the comb drive elements. Add another Electrical 
Ground (from the Draw menu) and connect it to the negative pin of the voltage source.  
 
Finally, select Draw…Output Probe, and add an output probe near the bottom right-hand corner of each of 
the plate elements. Connect the output probe to the “xm”, ”ym”, and ”zm” pins. These pins represent the 
displacement of the center of the plate, and connecting them to the output probe means that we will be 
monitoring the displacement as an output signal. 
 
Your schematic should now appear as shown below. 
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Figure 12 Gyro Model  

 
You can double click on any element to bring up the Device Properties window where you can set up the 
properties for that element. For example, double-clicking on any Beam element will allow you to change 
the material properties, layer information, and dimensions of the beam. 
 

 
Figure 13 Beam Parameters 
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For the Rigid Plate element, you can also add holes and define where each of the pins is located. 
 

 
Figure 14 Rigid Plate Parameters 

  
For a detailed description of each parameter associated with each element, you can refer to the Elements 
Documentation in the Help menu. From this point forward, we will use a saved schematic that includes all 
of the correct element parameter settings. For further information and any practice on creating SYNPLE 
schematics from scratch, please refer to the “Getting Started with SYNPLE” Guide in the Help menu. 
 
 

 Click      File…Open… 
 

Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/SYNPLE_Models/Element_Models/gyro_ac.ssc. 
 
This file should appear as shown in Figure 15. 
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Figure 15 Completed Gyro Model  

 
You can double click any element to view the parameter settings. To get a better idea of what this model 
really looks like, we can quickly view a solid model representation of the schematic. 
 

Click   Synthesis…Visualize Solid Model… 
 
Click   OK 
 

 
 

 
Figure 16 Visualize Solid Model   

 
A 3D model will appear as shown in Figure 17. 
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Figure 17 3D Model  

 
When you are finished examining the model, close VisualEase and return to the SYNPLE window. 
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2.2. AC Analysis 
 
We will perform an AC analysis to view the frequency response of the structure. 
 
      Click Simulation…AC Analysis 
 
The simulation settings are already set. To view the simulation settings, 
 
 Click Frequency Sweep 
 

  
Figure 18 AC Simulation Settings 

 
You can see that we will be analyzing 2001 points between 10 kHz and 20 kHz. To run the AC simulation, 
return to the AC Simulation window and click OK. 
 
When the simulation is completed, a Plot Manager window will appear. Here we can view magnitude and 
phase plots of the output signals we chose to monitor. The variables represent the x-, y-, and z-
displacements of the left proof mass, and RX, RY and RZ correspond to the displacements of the right proof 
mass. Select mag_of_LX_ac and click “Open in WaveRunner” to view the plot as shown below. 
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Figure 19 Frequency Response in X-direction 
 
The modal frequency in the x-direction is about 15.7 kHz. To view the frequency response in the y-
direction, open mag_of_LY_ac back in the Plot Manager window. 
 

 
Figure 20 Frequency Response in Y-direction 

 
The modal frequency in the y-direction is about 16.4 kHz. 
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Mode shapes and result animations can also be viewed after AC and Transient simulations.  As long as the 
All Nodes button is selected in the simulation setup, the MEMS 3D Visualization menu item will be active 
after the simulation has run. 
 

Click Simulation…AC Analysis 
Click Signals 
 

We will need results from all of the output signals to get an accurate 3D visualization.  Select All Nodes 
under the Signals tab in the DC Simulation dialog. 

 

 
 

Figure 21 Select all nodes for MEMS 3D Visualization 
 
Click OK to run the simulation.  After the simulation is complete, select MEMS 3D Visualization in the 
Results menu.   
 

 
Figure 22: 3D Visualization in Results Menu 

 
When VisualEase opens, choose “Disp-Norm of Mode 1” under the “Variable” box to view the mode shape.  
You can also enter a scaling factor in the Deformation Scaling box to get a better view of the behavior. 
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Figure 23: 3D Visualization of Mode 1  
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2.2.1 Damping and Quality factor 
 
In this section we will determine the damping factor and quality factor for the gyro structure. The 
interaction of the moving comb fingers and the surrounding fluid is the main source of damping for this 
structure. The damping factor is dependent on ambient parameters such as pressure, temperature and fluid 
viscosity. We will first examine the effect of these ambient parameters on the damping factor, then extract 
the quality factor. 
 

Click Tools…Ambient Parameter Manager 
 
The Ambient Parameter Manager with default parameters will appear as shown below.  
 

 

Figure 24 Ambient Parameter Manager 
 

In this case, we will not set up the ambient parameters in this window. Rather, we will run a parametric 
analysis to view the device response using multiple different values for the ambient pressure. 
 

Click    Simulation…AC Analysis 

Click    Parametric Setup tab 

Click     “+” button to add a parameter 

Click     Pressure as shown in Figure 22 

Click     Next 

Select Table as the Variation Type as shown in Figure 23. Input “101.325, 10132.5, 101.325k” (values in 
Pa) into the Table dialog box.  
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Figure 25 Selecting Parameters 

 

    
Figure 26 Parametric Settings 

 
Click Finish, then click OK to run the simulation. 
 
After the simulation is complete, select mag_of_LX_ac in the Plot Manager and click “Open in 
WaveRunner”. 
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Figure 27 Frequency Response 

 
You can see that the quality factor (peak magnitude divided by DC magnitude) varies with the changes in 
ambient pressure. You can use the Max-Min button in the toolbar to display maximum and minimum 
values of each of the curves, and you can use these values to determine the quality factor. At a pressure of 1 
atm, the Q factor is about 630. At 0.1 atm, the Q factor is about 1,000, and at 0.001 atm, it is about 22,000. 
 

 
Figure 28 Max/Min Values 
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2.3. DC analysis 
 
Open the following file: <InstallationDirectory>/IntelliSuite/Training/ 
Application_Notes/Gyro/SYNPLE_Models/Element_Models/gyro_DC.ssc. 
 
The DC schematic is shown below in Figure 26. 
 

 
Figure 29 DC Schematic 

 
This is the same schematic that we used for the AC simulations, but a DC voltage load will be applied to 
the comb drives.  Double-click the green Voltage Source element and make sure the load is set to 100 V. 
 

 
Figure 30 DC Voltage Source 

 
To run the analysis, 
 
      Click Simulation…DC Analysis 
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After the simulation runs, the DC displacement will show up in the message window at the bottom of the 
screen. 

 

 
Figure 31 DC Results 

 
The x-displacement LX or RX is about 0.22 um. Later, we will compare these results to those of our finite 
element model and reduced-order macromodel. 
 
We can also view simulation results using VisualEase. First, we’ll need to run the simulation once again 
with some different settings. 
 
 Click Simulation…DC Analysis 
 
We will need results from all of the output signals to get an accurate 3D visualization. Select All Nodes 
under the Signals tab in the DC Simulation dialog. 
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Figure 32: DC Simulation Dialog 

 
Click OK to run the simulation. After the simulation is complete, select MEMS 3D Visualization in the 
Results menu.   
 

 
Figure 33: 3D Visualization in Results Menu 

 
When VisualEase opens, choose Displacement X under the Variable box to view the x-displacement.  You 
can also enter a scaling factor in the Deformation Scaling box to get a better view of the behavior. 
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Figure34: Gyro in VisualEase 
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2.4. Transient Analysis 
 
Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/SYNPLE_Models/Element_Models/gyro_transient.ssc. 

 
The model will appear as shown below. 
 

 
Figure 35 Transient Schematic 

 
You can see that an AC Voltage Source is applied to the comb drives.  Double-click on the element to 
view the parameter settings. 
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Figure 36 AC Voltage Settings 

 
To run the simulation, 
 
 Click Simulation…Transient Analysis 
 
You will see that the simulation is set up to run for 5 milliseconds with a time step of 0.5 microseconds. 
 

 
Figure 37 Transient Settings 
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Click OK  
 

After the simulation is complete, select LX in the Plot Manager and click “Open in WaveRunner”.  A 
graph of the transient response in the x-direction will appear. 

 

 
Figure 38 Transient Response - X 

 
Open LY to view the response in the y-direction. 

 

 
Figure 39 Transient Response - Y 
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2.5. Coriolis Analysis 
 
A gyroscope is a sensor that measures the rate of rotation of an object. Most micro-machined gyroscopes 
use vibrating mechanical elements to sense angular velocity. Utilizing vibrating elements to induce and 
detect Coriolis forces presents many advantages (no rotating parts that require bearings, eliminating 
concerns about friction and wear). The fundamental operating principle of a vibratory gyroscope relies on 
the sinusoidal Coriolis force induced by the vibration of a proof-mass and an orthogonal angular-rate input. 
In this section we will apply an angular velocity to the structure and examine the resulting Coriolis force. 
 
Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/SYNPLE_Models/Element_Models/gyro_coriolis.ssc. 
 
The model will appear as shown below. 
 

 
Figure 40 Schematic for Coriolis Analysis 

 
You will see that a rotation input has been applied to the Global Frame element. 
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Figure 41 Rotation Input 

 
The General AC Source element is being used to apply a rotation. If you double-click on this element, you 
will see that the rotation frequency is 30 Hz and the amplitude is 100 deg/sec (or 1.75 rad/sec).  
 

 
Figure 42 AC Source Parameters 
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To run the simulation, 
 

Click Transient Analysis 
 

Click OK 
 
The results of the simulation are shown in the figure below. 
 

 

 
Figure 43 Simulation Results 

 
We see a small result signal because the Coriolis response is very small.  If we increase the angular 
velocity amplitude from 100 deg/sec to 1000 deg/sec, we will see a clearer Coriolis response. 
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2.6. Quadrature effect 
 
In reality, fabrication imperfections result in non-ideal geometries in the gyroscope structure, which in turn 
causes the drive oscillation to partially couple into the sense mode. This is called the “quadrature effect.” 
Typically, most of the coupling occurs in the suspension elements. Considering the relative magnitudes of 
the drive and sense oscillations, even extremely small undesired coupling from the drive motion to the 
sense mode could completely mask the Coriolis response. In the previous section, we saw that the Coriolis 
response resulting from a 1.75 rad/sec rotation input is much smaller than the undesired quadrature signal. 
 
Almost all suspension elements in real implementations of vibratory gyroscopes have elastic cross-coupling 
between their principal axes of elasticity. This phenomenon is called anisoelasticity and is the primary 
cause of mechanical quadrature error in gyroscopes. In this section we will analyze the quadrature effect 
using SYNPLE.  
 
A transient plot of the Coriolis response and quadrature signal is shown in the figure below. This Coriolis 
response is the result of a 500 rad/sec angular velocity input, chosen to obtain a large Coriolis response. 
The quadrature signal is the transient y-axis displacement result without any rotation input. The drive signal 
is the same for both curves.   
 

 
Figure 44 Coriolis and Quadrature Signals 

 
The figure shows a 90° phase shift between the Coriolis signal and the quadrature signal. This result is 
expected because the Coriolis force is proportional to the drive velocity, v, and the quadrature force is 
proportional to the drive position, x. You can use SYNPLE to further analyze the quadrature signal and 
design quadrature compensation features like mechanical element trimming or an electric loop.   
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2.7. Mask synthesis 
 
Once you have a schematic created in SYNPLE, it’s easy to extract a mask layout from the schematic.  
 

Click   Synthesis…Synthesize Mask Layout in Blueprint 
 

 
Figure 45 Synthesize Mask Layout 

 
Blueprint, IntelliSense’s layout editor, will automatically open with a mask layout for the structure. 
 

 
Figure 46 Mask Layout 

   
 

. 
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3.  Model Construction 

3.1. Layout 
 
We will be using a different mask that includes some sense electrodes for the gyro.  In Blueprint, open the 
following mask file:  
 
<Installation Directory>\IntelliSuite\Training\Application_Notes\Gyro\ 
Mech_System_Model\Gyro.msk. 
 
The model will appear as shown below. 
  

 
Figure 47 Gyro Layout 

 
 
When you are finished inspecting the mask, close the program. 
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3.2. Solid Structure Construction with 3D Builder 
 
To create a 3D meshed model from the mask layout for use in the analysis module, we will use a program 
called 3D Builder. 
 
To open the program, 
 
 Click Start…Programs…IntelliSuite…3DBuilder. 
 
The 3DBuilder window will appear. The left side of the window is used to manipulate the 2D layout of 
each layer. The right side of the window is used for 3D visualization and layer management. Select 
Automesh from mask layout in the Mesh drop-down menu. 
 

 
Figure 43 3D Builder Window  

 
In the dialog box that appears, 
 
 Click Browse… 
 
Select the following file: <Installation Directory>\IntelliSuite\Training\ 
Application_Notes\Gyro\Mech_System_Model\Gyro.msk. 
 
Because this structure is composed solely of straight lines and right angles, we will select the Manhattan 
mesh type.   
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Figure 48 Automesh Setup 

 
Click OK, and after a few seconds, the automeshed structure will appear. In the Levels Manager on the 
bottom right, you will see that Layer 0 is the device layer and Layer 1 is the anchor layer. 
 

 
Figure 49 Automeshed Structure 

 
Click the Modify Height button and input a value of 40 um.  The structure will then appear as below. 
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Figure 50 Solid Structure 

 
Click Mesh…Multiple Slices 
 

Select the beam highlighted in gray in the figure below, and input “10” in the dialog box that appears. 
 

 
Figure 51 Slicing Function 

 
Click OK 
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The beam will then be divided into 10 parts. Repeat the operation on each beam. Slice the longer beams 
into 10 segments and the shorter beams into 5 segments. When you are finished, the model should appear 
as shown below. 

 
Figure 52 Model with Refined Mesh 

 
In the Levels Manager on the bottom right, click the Split Level button. Input “3” in the dialog that appears. 
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Figure 53 Split Level Function 

 
The model will then appear as shown below. 
 

 
Figure 54 3D Solid Model 

 
Now we are ready to send the structure to the analysis module.  You will first need to save the 3D Builder 
file in a location of your choosing.  Then, 
 
 Click File…Export to Analysis Module… 
 
Click Continue without Check and select the ThermoElectroMechanical analysis module.  Save the 
analysis file, making sure not to use spaces in the file or folder names.   
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4.  ThermoElectroMechanical (TEM) Analysis 
The ThermoElectroMechanical Analysis Module (TEM) is the device-level Finite Element Analysis 
application developed by IntelliSense.  This module allows you to incorporate material properties, loads, 
and boundary conditions to fully analyze a device in the static, frequency, and dynamic domains.  One 
additional feature unique to IntelliSuite’s TEM is the ability to create N-DOF (N-degree-of-freedom) 
system models that can be imported into a system-level simulator like SYNPLE.  These models retain the 
accuracy of finite element-based models, but can be quickly simulated under multiple loading conditions in 
the system-level solver.  This functionality also allows you to co-simulate your CMOS control circuitry 
with your finite element-based MEMS device.  This is a very powerful capability only offered by 
IntelliSense that allows our users to fully develop their device from initial design exploration all the way 
through to full integration of the MEMS device with their circuit. 
 
In this section we will discuss the device-level simulation of the gyro.  We will set up the model and run 
Frequency, Static, Dynamic, and System Model Extraction simulations.  We work in this order so that we 
perform the simpler, faster simulations first (frequency and static).  Once we understand our model better, 
we will perform the more lengthy simulations (dynamic and SME). 
 
4.1. Setting up the model 
 
The first thing to do once we have our finite element model in the TEM is to choose a simulation setting 
and check the material properties. 
 
 Click Simulation…Simulation Setting. 
 
A window will appear showing all of the simulation types and their respective options. 
 

 
Figure 55 Simulation Setting Window 

 



 

39 

In the first simulation we will run is a Natural Frequency Analysis, so set the Calculation Type to 
Frequency, and the Analysis Type to Static Stress.  Set the simulation to analyze the first 6 modes using 
small scale displacement theory, an undeformed start shape, and no piezomaterial. 
 
Once we have the simulation set up, we can work on our material properties, loads, and boundaries. 
 
 Click Material…Check/Modify. 
 
Select the large entity that makes up the moving structure and it will turn red. The Material Properties 
dialog will appear as shown below with default settings for bulk silicon. You will see that you can choose 
to simulate isotropic, orthotropic, or anisotropic materials in the Elastic Parameter field. The simulator will 
also account for the effect of the wafer orientation on the material properties in the Orientation field. In this 
case we will leave the settings as the default and assume an isotropic material. 
 

 

 
Figure 56 Material Properties 

 
Click OK 
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The material properties of the rest of the entities do not matter in this case because they will be used for 
electrostatic purposes only; none of them will move. 
 
Once we have verified the material properties, we need to apply the boundary conditions for the model.  
In this example, we will only use the Fixed boundary condition. 
 
 Click Boundary…Selection Mode…Pick on Geometry 
 Click Boundary…Fixed 
 
Select each of the red faces shown in the figure below.   
 

 
Figure 57 Fixed Faces 

 
When you have finished applying the fixed boundary conditions, check to see that they have all been 
applied. 
 
 Click Boundary…Selection Mode…Check Only. 
 Click Boundary…Fixed. 
 
The software should go through a command prompt, and all of the fixed faces will appear in bright red as 
shown in the above figure. 
 
The final step in setting up a model in TEM would be the application of loads. In the first simulation, we 
will only be running a natural frequency analysis, so we do not have any loads to apply at this point.  
When we begin performing the electrostatic simulation, we will apply our voltage loads. 
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4.2. Frequency Analysis 
 
Because we have already set up the simulation with the correct material properties and boundaries, the 
frequency analysis is easy to complete. 
 
 Click Analysis…Start Frequency Analysis 
 
The frequency analysis will take 2-3 minutes.  While it is running, a command prompt will be visible on 
your computer screen which will disappear when the analysis has completed.  After the simulation, the 
results available to you will be the list of natural frequencies and animations of each mode shape.  These 
can be found next to each other in the Result menu. 
 

 
Figure 58 Result Menu 

 
 Click Result…Natural Frequency 
 
You will see the list of natural frequencies shown below. 
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Figure 59 Natural Frequency Results 

 
If you want to view the animation of one of the natural frequencies, 
 
 Click Result…Mode Animation 
 
This will bring up a window that will ask you for the mode number of the natural frequency you want to 
animate and ask you to provide a scaling factor.  
 

 
Figure 60 Mode animation selection box 

 
Select 3 for the mode number and 40 for the scaling factor.  When the mode animation begins, you will 
see both of the masses of the gyro moving out of phase in the x-direction.  If you select mode 2, you will 
see them moving in phase.  The first six mode shapes are shown below.  
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Figure 61 Mode animation  

 
Modes 1 and 6 correspond to the movement of the masses in the z-direction. Modes 2 and 3 correspond to 
the movement of the masses in the x-direction. Modes 4 and 5 correspond to the movement of the masses 
in the y-direction. We will be driving the gyro in the x-direction and the resultant movement y-direction 
will be used to sense changes in the capacitances.  We will use mode 3 as the drive mode and mode 4 will 
be our sense mode.  Now that we understand the important modes of the gyro, and we have confirmed that 
our boundary conditions are correct, we can move on to static simulations. 
 
4.3. Static Simulation 
 
For a static simulation we will perform a simple voltage-induced displacement analysis where we actuate 
the drive combs to and determine the displaced shape of the gyro.  We have already created a file for you 
that you can use to run the simulation. 
 
Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/Device_Models/Gyro.save 
 
Make sure the simulation settings are set up as shown in the figure below. 
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Figure 62 Static Simulation Settings 

 
For this analysis, we will need to apply voltage loads to three of the conductors.  Later when we are 
looking at the transient case and looking at the Coriolis force response of the sense capacitances, we will 
define other conductors.  In this simulation, we only care about the drive combs and the moving mass.  
To apply a Voltage load, 
 
 Click Loads…Selection Mode…Pick on Geometry 
 Click Loads…Voltage…Entity 
 
Apply a 100 V voltage load on fixed side of drive combs and 0 V on the moving mass as shown in the 
figure below. 
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Figure 63 Voltage Loads 

 
Now the simulation is set, the material properties are correct, the boundaries are defined, and the loads have 
been applied.  The final step is the mesh refinement. 
 
With all finite element solvers, a solution is more accurate with a more refined mesh.  One thing that is 
special to IntelliSuite and its TEM is the ability of the user to decouple the mechanical and electrostatic 
meshes.  This allows the user to define where the important mechanical elements are and where the 
important electrostatic elements are.  In this particular case, the important mechanical elements are the 
spring supports and the important electrostatic elements are the comb drives. 
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For this device, the mechanical mesh refinement has already been done in Section 3.2. Each part of the 
spring was broken up into multiple segments. 
 

 
Figure 64 Refined Mechanical Mesh 

 
To check the electrostatic mesh,  
 
 Click Mesh…Selection Mode…Check Only 
 Click Mesh…Elec_Mesh 
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Figure 65 Electrostatic Mesh 

 
One thing that you will notice about the electrostatic mesh is that most of the device is being ignored (even 
most of the drive combs!).  This is done because the only parts of the device that will be interesting 
electrostatically are the drive combs and the sense electrodes.  In this particular example, we will only 
worry about the drive combs.  If you were to perform a noise analysis, you would want to examine more 
of the sense electrodes. 
 
In setting up this electrostatic mesh, we are taking advantage of a feature called Multi-bank Exposed Face 
Meshing (MEFM). The electrostatic forces are generated by the electrostatic mesh and then applied to the 
mechanical mesh.  Each identical comb finger will see the same electrostatic forces, and because of this, 
we can simulate one finger and tell the software how many other duplicates there are.  The software will 
apply the electrostatic pressures to the device accordingly.  This is yet another feature specific to 
IntelliSuite that allows users to accurately simulate their electromechanical devices with far greater 
efficiency than our competitors. 
 
Once you have checked out the simulation settings, material properties, loads, boundaries, and mesh, it’s 
time to run the simulation. 
 
 Click Analysis…Start Static Analysis 
 
When the simulation is running, you will see a command prompt.  This prompt will display some data 
about the status of the simulation (what iteration step it’s on, the maximum displacements in the x, y, and z-
directions).  The simulation should take about 3-5 mins to run.  Once the command prompt disappears, 
the simulation is complete and you can view the results. 
 
 Click Result…Displacement…X 
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Figure 66 Static Results in the X-direction 

 
You can also view capacitance matrices, charge densities, electrostatic pressures, stresses, etc.  Feel free 
to explore the results menu.   
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4.4. Spring softening effect 
 
Electrostatic forces resulting from an external DC voltage source will change the stiffness of a structure and 
reduce the resonant frequency. This effect is called electrostatic spring softening, and we will examine its 
effect on this gyro model.  
 
Set up the simulation to run a frequency analysis as shown in the figure below. 
 

 
Figure 67 Simulation Settings 

 
Click OK 
 
Click Loads…Voltage…Entity 

 
The voltage on the moving entity will remain at 0 V. Click on the fixed comb drive element. Click the 
“Input Value Range” tab in the dialog that appears, and set the voltage to sweep from 0 to 40 V as shown 
below. 
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Figure 68 Voltage Settings 

 
Click OK 

 
To run the simulation,  
 

Click Analysis…Start Frequency Analysis 
 
When the simulation is complete,  

 
 Click Result…2D Plot, Electromechanical Analysis… Y Coordinate…Natural Frequency    
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Figure 69 Results Menu 

 
In the window that appears, select modes 3 and 4 (drive and sense modes).  The results will appear as 
shown below. 
 

 
Figure 70 Frequency vs. Voltage 

 
In the above figure we see that under a certain bias voltage, the resonant frequency of the sense mode is 
near the resonant frequency of the drive mode. This kind of gyro is called a mode-matched tuning-fork 
gyroscope (M2-TFG). The greatest advantage of an M2-TFG is that the rotation-induced Coriolis signal is 
amplified by the mechanical quality factor of the sense mode.  Due to the Q factor amplification, an M2-
TFG operated under the mode-matched configuration will offer a higher sensitivity and better resolution.  
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4.5. Dynamic Simulation 
 
The static simulation is complete, now it is time to run the device under a dynamic load.  How will we 
actuate the device?  We will use the two drive combs, but we have to determine the frequency of the AC 
voltage source.  We want to actuate the gyro at one of the natural frequencies of the device.  With this 
gyro, the third mode (when the masses move in opposite directions along the x-axis) is the drive mode.  
This mode has a frequency of 15,615 Hz.  Because we want to have a sampling rate of about 10-15 points 
per cycle we need to have a sampling rate of ~200,000 Hz.  We will examine the first five cycles, so we 
will look at the first 200 microseconds and examine 20 steps for the startup. 
 
Set the simulation as shown below. 
 

 
Figure 71 Dynamic Simulation Settings 

 
First, we have to reset the static voltages on the drive combs. 
 
 Click Loads…Voltage…Entity 
 
Select the fixed comb drive entity and change the voltage from 100V to 0V.  The next step is to apply the 
AC voltage. 



 

53 

 
 Click Loads…Amplitude vs. Time…Periodic 
 Click Loads…Voltage…Entity 
 
Select the fixed comb drive entity and set the voltage as shown in Figure 72. 
 

 
Figure 72 Dynamic Voltage Settings 

 
We also have to set up the dynamic damping definitions. 
 
 Click Material…Damping Definition 
 
Select the moving entity and input 78 for the Mass_damping factor and 0 for the Stiffness_damping. This 
corresponds to a damping ratio of 0.005 for both the drive (15.6 kHz) and sense (16.3 kHz) natural 
frequencies. (See the TEM Help in the Help menu for more information on how to calculate these values.) 
Once the damping definitions have been set, we need to set up the Coriolis force resulting from the rotation 
of the device. 
 
 Click Loads…Amplitude vs. Time…None 
 Click Loads…Coriolis Force 
 
Select the moving mass (large entity) and input the below values for the Coriolis force. 
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Figure 73 Coriolis Force Settings 

 
The magnitude of the Coriolis force load is defined as the mass density multiplied by the angular velocity. 
For the current structure, the density is 2.33 g/cm^3.   If the angular velocity is 1.75 rad/sec (100 
deg/sec),  then the Coriolis force can be defined as 4.078 g/(second* cm^3). The z-axis (0, 0,1) is the axis 
of rotation. 
 
 Finally, it is time to run the transient simulation. 
 
 Click Analysis…Start Dynamic Analysis 
 
The dynamic analysis will take about 24 hours, possibly more.  The results are displayed below.  If you 
want to view the results on your computer without having to run the simulation, send us an email 
(support@intellisense.com) to request the result file.  This file is quite large (~250MB) which is why it is 
not included in your installation. 
 
The important dynamic results, the displacements in the x- and y- directions of the two moving masses, are 
shown below. 
 

  
Figure 74 X-Displacement on Mass 1  Figure 75 X-Displacement on Mass 2 
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Figure 76 Y-Displacement on Mass 1  Figure 77 Y-Displacement on Mass 2 

 
You’ll notice that the two masses move opposite each other along the x-axis and in the same direction 
along the y-axis. It is also important to notice that we have only run the simulation for three cycles. This is 
too short of a time frame to determine the full start-up effect of the gyro.  We may need to run fifty cycles 
or more to see the full response. With the simulation of three cycles taking 24 hours to complete, you can 
easily see why system modeling using a reduced-order model is so important.  With the System Model 
Extraction feature, we can generate a system model of the device in less than 2 hours.  We can then import 
that model into SYNPLE and run a full transient analysis of the start-up response in a matter of seconds. In 
the next section we will demonstrate how to extract a system model and incorporate that model into 
SYNPLE. 
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4.6. System Model Extraction 
 
System Model Extraction is a means by which a full three-dimensional meshed numerical model of a multi-
conductor electromechanical device without dissipation can be converted into a reduced-order analytical 
macromodel. This can then be inserted as a black-box element into a mixed signal circuit simulator. This 
process is based upon the energy method approach, in that we construct analytical models for each of the 
energy domains of the system and determine all forces as gradients of the energy. 
 
The energy method approach has the advantage of making this process modular, enabling us to incorporate 
other energy domains into our models in the future. Another beneficial side effect of energy methods is that 
the models we construct are guaranteed to be energy conserving, because each of the stored energies is 
constructed as an analytical function, and all forces are computed directly from analytically computed 
gradients. The SME process also has the advantage of being able to be performed almost entirely 
automatically, requiring the designer only to construct the model, run a few full three-dimensional 
numerical computations, and set a few preferences a priori. Above all, this process has the ultimate benefit 
of constructing models that are computationally efficient, allowing their use in a dynamical simulator.  
 
Our first task is to reduce the degrees of freedom of the system. Rather than allow each node in a finite 
element model to be free to move in any direction, we constrain the motion of the system to a linear 
superposition of selected set of deformation shapes. This set will act as our basis set of motion. The 
positional state of the system will hence be reduced to a set of generalized coordinates, each coordinate 
being the scaling factor by which its corresponding basis shape will contribute. Next, we must construct 
analytical macromodels of each of the energy domains of the system. In the case of conservative capacitive 
electromechanical systems, these consist of the electrostatic, elastostatic, and kinetic energy domains. 
These macromodels will be analytical functions of the generalized coordinates. (As we will see in the 
section on Using Mode Shapes as a Basis Set, some of these energy domains will be determined as a 
byproduct of modal analysis, avoiding the need for explicit calculation.) We can then use Lagrangian 
mechanics to construct the equations of motion for the system in terms of its generalized coordinates. 
Finally, we can translate these equations of motion into an analog hardware description language, thereby 
constructing a black-box model of the electromechanical system that can be inserted into an analog circuit 
simulator.  
 
The Figure below gives the Flow Chart for the conversion of an FEA model into an equivalent system level 
mode. 
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Figure 78 Creation of a Macromodel 

 
Some of the key equations used for the conversion process are discussed in this section. In general, the 
deformation state and dynamics of mechanical system can be accurately described as the linear 
combination of mode shape function or modal superposition. 
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Where ui represents the deformed state of the structure, ueq represent the initial equilibrium state (derived 
from the residual stress conditions without external loads), Φj represents the displacement vector for the jth   

mode, qj represents the coefficients for the jth mode, which is referred as “scaling factor for mode j”. In 
general, (Eq. 1) describes a coordinate transformation of finite element displacement coordinates to modal 
coordinates of the macromodel. The deformation state of the structure given by n nodal displacements 
ui(i=1,2,…,n) is now represented by a linear combination of m mode weighted by their amplitudes 
qj(i=1,2,…,n) where m<<n. The governing equation of motion describing the ROM of electrostatic 
actuated MEMS structures in modal coordinates is given by: 
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Where mj is the modal generalized mass, ωj the modal eigenfrequency, ξj the linear modal damping ratio, 
Wst the modal strain energy function, Cks the modal capacity-stroke function, r the number of capacities 
involved for Microsystems with multiple electrodes, Vks the electrode voltage applied between electrode k 
and s, and Fi a local force acting at the i-th node. The modal strain energy and capacity-stroke functions are 
derived from a series of FE runs at various deflection states in the operating range. 
 
The modal superposition method is efficient since just one equation per mode and one equation per 
conductor is necessary to describe the coupled system entirely, which can be applied to both linear and 
nonlinear geometry. 
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The modal superposition based reduced order modeling procedure includes the following steps: 
 

• Determine the “Modal Contribution”. In this step, the software performs the standard 
electromechanical relaxation analysis and solves the initial deformed state (derived from the 
residual stress without external loads) and the final deformed state (with mechanical loads and 
applied voltages). It then uses the QR factorization algorithm to determine the modal contribution 
for the deformed state. 

• Calculate the relationship of “strain energy vs modal amplitudes” for each mode. 
• Calculate the relationship of “mutual capacitance vs modal amplitudes”. 
• From step 2 and 3, the user will obtain ∂Wst(q)/∂qj and ∂C(q)/∂qj respectively. 

 
4.6.1 Extracting the Electromechanical Macromodel in TEM 
 
We will be performing a Macromodel Extraction so set the simulation as such. 
 

Click Simulation…Simulation Setting 
 
Set up the simulation as shown below. 
 

 
Figure 79 ElectroMechanical Macromodel Extraction Simulation Settings 
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Now that the simulation is set up, check that the material properties and boundaries are properly set as 
described in the static simulation setup on page 38. We will apply a voltage load while calculating the 
modal contribution.  This is especially useful if you do not know exactly which modes will be important.  
If you apply loads that approximate the loading conditions you expect to see in the actuation of the device, 
you will be able to determine which modes contribute most to the deformation caused by the actuation 
loads.  This allows you to run your macromodel extraction while focusing on the correct modes.  Apply a 
voltage load of 100 V to the comb drive entity and 0 V to the moving mass. 
 

 
Figure 80 Voltage Loads 
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Once the loads have been set, run the analysis. 
 
 Click Analysis…Start Extract Macromodel 
 
When the analysis is complete (it should take only a few minutes) you can view the contribution of each 
mode to the deformation of the device. 
 
 Click Result…MacroModel…Modal Contribution 
 

 
Figure 81 Modal Contributions 

 
In this example we will use all six of the modes we have examined in our strain energy calculation step.  
If you wanted to reduce the time needed for the strain energy step, you could easily disable any of the 
modes so they would be ignored during the strain energy simulation. 
 
 Click Simulation...Simulation Setting 
 
Set up the strain energy step as shown below. 
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Figure 82 Strain Energy Simulation Settings 

 
Leave the scaling factor and increment number as the default values for modes 1, 2, 4, 5 and 6.  For mode 
3, set the scaling factor to 5 and the increment number to 25 as shown above.  This will examine the strain 
energy for a wider range of motion for mode 3.  Because mode 3 is the drive mode, it will be the mode 
that will experience the largest range of motion under actuation conditions.  Once you have set up the 
simulation for the strain energy calculation, you are ready to run the analysis, as all of the material 
properties, loads, and boundaries have already been set up. 
 
 Click Analysis…Start Extract Macromodel 
 
When the analysis is complete you can see the strain energy vs. modal amplitudes graph for each mode. 
 
 Click Result…MacroModel…Strain Energy vs Modal Amplitudes 
 
To show a plot of the strain energy vs. scaling factor for a particular mode, double-click on the mode 
number and click OK.   
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Figure 83 Strain Energy vs. Mode 3 Scaling Factor 

 
We will now set up the final simulation step. Click Simulation…Simulation Setting and set up the 
simulation as shown below. 
 

 
Figure 84 Capacitance Simulation Settings 
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Click     OK 
 
Click Analysis…Start Extract Macromodel 
 

After the simulation has run, we need to select the representative nodes that will be used to view the output 
displacements and apply any mechanical loads that we need.  In this case we will look at the center points 
of each of the two proof masses. 
 
 Click Boundary…Macromodel…Representative Nodes 
 
Select the nodes shown in the figure below.  The representative node information will be saved in the file 
named “macmodel.out”. 
 

        

   
Figure 85 Representative Nodes 

 
When you have selected the representative nodes the macromodel extraction is complete.  Copy the 
“curr.macromodel,” “macromodel.out,” and “str.out” files from the active directory and place them in a 
new directory for use with SYNPLE.  Be sure to move these files to a new folder, as they will be 
overwritten in the current directory if you run another simulation.  
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5.  Macromodel Simulation in SYNPLE 
You’ll remember from earlier that the dynamic simulation using finite element methods took multiple 
hours to complete. The system model extraction when run efficiently should take you less than one hour.  
You’ll see from this section that constructing a SYNPLE schematic and running a simulation takes very 
little time as well.   
 
5.1. Macromodel Setup 
 
First, open SYNPLE. 
 
 Click Start…Programs…IntelliSuite…SYNPLE 
 
Click and drag the Macro-Model-I element from the MEMS Devices element library on the left into the 
drawing window. 
 

 
Figure 86 Macromodel Element 

 
The next step is to link the macromodel element to the macromodel file we have extracted. Click on the 
Macromodel element to highlight it. 
 

Click Tools…Load ROM Macro-model 
 
To load the macromodel, find the location of your macromodel files, select the “curr.macmodel” file, and 
click Open. This will bring up a verification dialog box to let you know that the macromodel has been 
properly loaded and linked to the element.  You can also use the macromodel file located at  
 
<Installation Directory>\IntelliSuite\Training\Application_Notes\Gyro\ 
Macromodel\curr.macromodel. 
 



 

65 

To validate the macromodel extracted from TEM module, we need to perform a pure mechanical 
simulation and compare the results to the results obtained in the TEM module. We will perform two 
analyses here, one AC and one DC. The first step is to build and verify the mechanical system without the 
electrical components. After we have verified the mechanical system, we will run a transient analysis and 
then begin to incorporate a Coriolis feedback loop and electrical components for drive and sense. 
 
5.2. AC Validation 
 
You will recall from the TEM Natural Frequency simulation that the drive frequency is 15.6 kHz. This can 
be easily duplicated in SYNPLE. With SYNPLE open, 
 
 Click File…Open 
 
Open the following file: <Installation Directory>\IntelliSuite\Training\ 
Application_Notes\Gyro\SYNPLE_Models\Mechanical-AC_Validation.ssc. 
 
This file should appear as shown below. 
 

 
Figure 87 SYNPLE Schematic for AC Simulation 

 
You can play around with any of the elements by double clicking on them. You will see an 
Electrical_Ground element used to set the electrical reference node of the macromodel element. Two 
General AC Source elements are used to set up the x-direction drive forces at the representative nodes. One 
Constant element is used to set the forces in non-interesting direction and non-used nodes as zero. Finally, 
two Output Probe elements are included to monitor the displacement of the representative nodes 
 
First, load the macromodel file as discussed earlier. 
 

Click Tools…Load ROM Macro-model 
 
Load the following macromodel file: <InstallationDirectory>\IntelliSuite\Training\ 
Application_Notes\Gyro\Macromodel\curr.macromodel. 
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 Click Simulation…AC Analysis 
 
The simulation settings are already set. To view the simulation settings, 
 
 Click Frequency Sweep 
 

  
Figure 88 Frequency Sweep Selection and Settings 

 
You can see that we will be analyzing 1000 points between 100 Hz and 100,000 Hz.  
 
In the Signals tab, check that we are analyzing the x1 and x2 signals, representing the x-displacement of 
our representative nodes. 
 

 
Figure 89 AC Simulation Signals 

 
You can check the convergence criteria, but they should be left as the default.  Run the AC simulation. 
 
 Click OK 
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When the simulation is complete, the Plot Manager window will appear with the simulation results. 
 

 
Figure 90 Plot Manager 

 
Open mag_of_x2_ac or mag_of_x1_ac to view the x-displacement results. 
 

 
Figure 91 AC Results 

 
You should notice that the natural frequency appears at 15.6 kHz.  The AC simulation in SYNPLE 
produces the same results as the TEM simulation, thus the mechanical model is translating properly.  The 
next step is to check the DC simulation results when we use a comb drive. 
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5.3. DC Validation 
 
If you look back at the TEM simulation, the x-displacement of the moving masses under a static load of 
100 V on the drive combs is ~ 0.22 microns. We want to see how accurately we can duplicate this result 
with the macromodel simulation in SYNPLE. Open the DC simulation schematic. 
 
 Click File…Open 
 
Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/SYNPLE_Models/Mechanical-DC_Validation.ssc. 
 
The schematic is shown below. 
 

 
Figure 92 DC Schematic 

 
You will see that the Comb Drive and Voltage DC Source elements are connected to the macromodel using 
the Splitter element (found in the Draw menu). You can double-click on any of the elements to view the 
parameters and find more information in the Elements Documentation file under the Help menu. 
 
The simulation is already set up, so 
 
 Click Simulation…DC Analysis 
 
 Click OK 
 
When the simulation is complete, you will see the results in the Messages window.  This window will 
display the results of the DC simulation for each signal that was selected.  The important signals here are 
the forces applied by the comb drives, f1 and f2, and the displacements of the two moving masses, x1 and 
x2.  The results are shown below. 
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Figure 93 DC Simulation Results 

 
When you compare the results from the SYNPLE analysis to the results from the TEM analysis, you see 
about a 5% difference.  This is because there are fringe field effects that get taken into account in the TEM 
that are not taken into account in SYNPLE.  The comb drives that we use have an overlap to thickness 
ratio of 0.4; this is very low, and thus 3D effects will dominate.  The 2D comb drive generator cannot take 
this into account, and thus the results show some inaccuracy.  However, this inaccuracy is not extremely 
large, and we can still generate a very good model for transient simulation that we can use to optimize our 
structure and controls.   
 
5.3.1 Benchmarks 
 
Both the AC and DC results match up very well between the SYNPLE element-based model, TEM finite 
element model, and SYNPLE macromodel.  Results for the natural frequency of the drive mode and the 
DC static displacement from each of the models are listed below. 
 

 Element-based
model 

3D FEA 
(TEM) Macromodel 

Drive mode (Hz) 15.7 K 15.6 K 15.6 K 

DC displacement 0.22 um 0.21 um 0.22 um 
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5.4. Mechanical Macromodel Transient Simulation 
 
Open the following file: <Installation Directory>/IntelliSuite/Training/ 
/Application_Notes/Gyro/SYNPLE_Models/Mechanical-No_Feedback.ssc. 

 

 
Figure 94 Mechanical Macromodel Schematic 

 
If you double click on the any of the symbols, for instance the General AC Source, you can view the 
element parameters as shown below. The outputs of these two sources have the same amplitude and 
frequency but a 180 degree phase difference so that we actuate mode 4. 
 

  
Figure 95 General AC Source Parameters 

 
Once you have finished checking out the elements, run the transient analysis.  
 

Click Simulation…Transient Analysis 
 

Make sure the simulation parameters are set up as shown below. 
 



 

71 

 
 

      
   

      
Figure 96 Transient Simulation Setup 

 
Click OK  

 
Once the analysis is complete, the Plot Manager will appear with the selected signals. The message window 
will also show you where the simulation result data has been saved. All SYNPLE results are saved in a 
format that can easily be opened by Microsoft Excel or any other database editor. 
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Figure 97 Completed Simulation with Plot Manager 

 
Double click on any of the signals to view the plot of the results. 
 
The plot of x1 vs. time will appear as shown below. 
 

 
Figure 98 Plot of x1 vs. Time 
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5.5. Incorporating the Coriolis Feedback 
 
To simulate the Coriolis effect in the gyro design, we can apply a Coriolis force feedback to the 
representative node in the y-direction.  The Coriolis force can be expressed by the following equation: 

)2()(
dt
dxfmvmFCoriolis πω −=×−=

rr
 

Open the Coriolis feedback schematic at <Installation Directory>/IntelliSuite/ 
Training/Application_Notes/Gyro/SYNPLE_Models/Mechanical-Coriolis.ssc. 
 
The schematic will appear as shown below. 
 

 
Figure 99 Coriolis Feedback Schematic 

 

 
Figure 100 Coriolis Force Feedback Loop 

 
You will see that Derivative, Multiplication, and Multiplier elements (in the Math sub-folder in the General 
Elements library) are used to apply the Coriolis force. When you are finished inspecting the elements, you 
can run the simulation. 
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Click Simulation…Transient 

 
Set the simulation parameters as shown below: (Make sure that the signals y1 and y2 have been selected as 
well) 
 

  
 

  
Figure 101 Transient Coriolis Force Simulation Settings 

 
To start the analysis, 
 

Click OK  
 
Once the analysis is complete, the signal manager with the selected signals will appear. 
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Figure 102 Coriolis Simulation Results 

 
The displacement and Coriolis force results are shown below. 
 

 
Figure 103 Transient Plot of x1 vs Time 
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Figure 104  Transient Plot of y1 vs Time 

 

 
Figure 105 Transient Plot of Coriolis_1 vs Time 
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Figure 106  Transient Plot of Coriolis_2 vs Time 

 
You will notice that the force and the response are in the opposite direction for points 1 and 2.  This is 
because the two masses are always moving in opposite directions. 
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5.6. Incorporation of the Drive Combs 
 
The proof masses of the gyro are driven by two comb drives. We can add Comb Drive elements to the 
schematic instead of simply applying a voltage on a node.  This will allow us to run parametric analysis 
on the comb drive parameters to determine the optimal comb drive. We can consider questions like: How 
many fingers do we want to use? What gap do we want to use? How long should the fingers be? 
 
A schematic which includes comb drives is located here:  
 
<Installation Directory>/IntelliSuite/Training/Application_Notes/Gyro/ 
/SYNPLE_Models/Mechanical-Comb_Drive.ssc 
 

 
Figure 107 Schematic with Drive Combs 

 
This file is ready for simulation. 
 
 Click Simulation…Transient 
 Click OK 
 
The simulation results are shown below. 
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Figure 108  Transient Result of x1 

 

 
Figure 109  Transient Result of y1 
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5.7. Including the Sense Electrodes 
 
The displacement of proof masses will be sensed by two electrostatic gaps. The Electrostatic Gap elements 
take the displacements in the x-y plane as input variables.  There are many parameters of the Electrostatic 
Gap element which are described in more detail in the “Getting Started with SYNPLE” or “Elements 
Documentation” manuals. 
 
Open the file:   
 
<Installation Directory>/IntelliSuite/Training/Application_Notes/Gyro/ 
/SYNPLE_Models/Mechanical-Constant.ssc 
 

 
Figure 110 Full Schematic with Sense Gaps 

 
This file is ready for simulation. 
 
 Click Simulation…Transient 
 Click OK 
 
We have schematics set up for two loading conditions: one for a constant rotation and one for a sinusoidal 
rotation.  Feel free to examine them. You can examine the different wave sources by double clicking on 
them in the schematic (they have been applied as the rotation in the Coriolis feedback loop) and their value 
has been selected as the output signal “omega”.  They are located here: 
 
<Installation Directory>\IntelliSuite\Training\Application_Notes\Gyro\ 
SYNPLE_Models\Mechanical-Constant.ssc 
 
<Installation Directory>\IntelliSuite\Training\Application_Notes\Gyro\ 
SYNPLE_Models\Mechanical-Sine.ssc 
 
The results are shown below. 
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Figure 111 Capacitance Response to a Constant Rotation input 

 

 
Figure 112 Capacitance Response to a Sine Wave Rotation input 
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6.  EDA Linker 
In this section we will use EDA Linker to convert our macromodel to other HDLs (hardware description 
languages). EDA Linker provides a convenient link between IntelliSuite’s TEM module and system level 
simulators like VHDL-AMS, SPICE, and Simulink.  
 

Click Start…Programs…IntelliSuite…Utilities… EDA Linker 
 

 
Figure 113 EDA Linker Window 

Click Next 
 

 
Figure 114 Macromodel File Selection 
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Select the desired macromodel file, then 
 

Click  Next 
 

 
Figure 115 HDL Model Generation 

 
Enter a name for the HDL model and specify the degree of polynomial for curve fitting. Note that in most 
cases, four- or five-degree polynomials are sufficient; ten-degree polynomials are the maximum. If you find 
that the resulting model is not sufficiently accurate, you may use a higher order polynomial. The last step is 
to select a modeling language. In the current version of EDA Linker, the following formats are supported: 
VHDL-AMS, PSPICE/SIMetrix, HSPICE, Simulink MEX S-Function. More languages will be available in 
future versions. After filling all the blanks, 
 

Click  Next 
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Figure 116 Save HDL Model 

 
The source code of the generated HDL model is displayed but cannot be edited in this tool. Specify a path 
and a filename for the HDL file and click Next to save it.  
 

 
Figure 117 Model Conversion 

 
Click Finish to quit EDA Linker. You can use this procedure to create HSPICE, PSPICE and 
Simulink/Matlab models in addition to VHDL models. We have already created these HDL models for the 
gyro; you can find them here: <Installation Directory>\IntelliSuite\Training\ 
\Application_Notes\Gyro\HDL_model\. 
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7.  Summary 
IntelliSense provides tools that integrate through all levels and stages of the MEMS design cycle.  Users 
can develop their device from the bottom up using a SYNPLE element model and mask synthesis or from 
the top down using System Model Extraction and circuitry integration. 
 
SYNPLE is a great tool for initial design exploration.  Parametric analysis and optimization features allow 
a designer to explore a large design space very quickly.  Once a schematic has been constructed, it is easy 
to automatically extract a mask layout or meshed model to use for further analysis. 
 
At the device level we provide a fully capable finite element solver, the ThermoElectroMechanical 
Analysis module (TEM).  The TEM uses Exposed Face Meshing methods to de-couple the mechanical 
and electrostatic meshes of devices.  This allows our users to perform mechanical mesh refinement in 
areas with high stress gradients and electrostatic mesh refinement in areas of high charge density.  This 
greatly simplifies the mesh needed for the device without sacrificing any accuracy.  This alone can save 
an order of magnitude on time. 
 
IntelliSuite is the perfect tool for gyro design.  Gyros are, by nature, coupled systems.  The TEM is 
optimized for mixed domain analysis, and models can be exported to system level solvers for quick 
transient analysis as well as CMOS integration.  System Model Extraction and SYNPLE modeling saves 
an incredibly large amount of time when compared to our own finite element solver, while our own FE 
solver saves time over our competitor’s.  When you compare the time required to run a full dynamic finite 
element analysis to the time required to run a system model extraction and dynamic analyses in SYNPLE, 
SME with SYNPLE is orders of magnitude faster.  Running optimization analyses with SME and 
SYNPLE can take a few hours, while running multiple optimization analyses with a FE solver would take 
days, weeks, or possibly months depending on the extent of the optimization. 
 
Because gyros are complex structures with many degrees of freedom, it is absolutely necessary to utilize 
the N-Degree of Freedom (N-DOF) System Models that the TEM produces.  6-DOF models will not 
produce results anywhere near the accuracy of the N-DOF models for gyro devices.  These N-DOF 
models give users a much better idea of how their device is going to react to its control circuitry. 
 
For more information on the unique advantages of IntelliSuite when it comes to gyro design, feel free to 
contact us at info@intellisense.com. 
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